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INTENDED USE 

The guidelines describe the procedure of using AmpliSens® Escherichioses-FRT PCR kit 

for qualitative detection and differentiation of DNA of different groups of diarrheagenic 

E.coli – enteropathogenic (EPEC), enterotoxigenic (ETEC), enteroinvasive (EIEC (in 

conjunction with Shigella spp.)), enterohemorrhagic (EHEC), and enteroaggregative 

(EAgEC), – in environmental samples and biological material by the polymerase chain 

reaction (PCR) with real-time hybridization-fluorescence detection using the following 

instruments: 

­ Rotor-Gene 3000, Rotor-Gene 6000 (Corbett Research, Australia), 

­ Rotor-Gene Q (QIAGEN GmbH, Germany),  

­ iCycler iQ5 (Bio-Rad Laboratories, Inc., USA),  

­ Mx3000P (Stratagene, USA) 

­ CFX96 (Bio-Rad Laboratories, Inc., USA). 

Correspondence of the fluorophores and detection channels 

Channel for the fluorophore Detection channel name for different instrument models1 

FAM FAM/Green 

JOE JOE/HEX/R6G/Yellow/Cy3 

ROX ROX/Orange/TxR 

                                                 
1 The detection channels names in each section of the guidelines are specified in accordance with the 
described instrument. 

http://en.wikipedia.org/wiki/Enteroinvasive_Escherichia_coli
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AMPLIFICATION AND DATA ANALYSIS USING Rotor-Gene 3000/6000 (Corbett 

Research, Australia) and Rotor-Gene Q (QIAGEN GmbH, Germany) INSTRUMENTS 

When working with Rotor-Gene 3000 one should use the Rotor-Gene Version 6 software 

and the Rotor-Gene 6000 versions 1.7 (build 67) software or higher for Rotor-Gene 6000 

and Rotor-Gene Q instruments. 

Hereinafter, all terms corresponding to different instruments and software are 

indicated in the following order: for Rotor-Gene 3000 / for Rotor-Gene 6000/Q. 

Carry out the sample pretreatment and reaction mixture preparation stages according to 

the PCR kit Instruction Manual. When carrying out the amplification it is recommended to 

use thin-walled PCR tubes (0.2 ml) with flat caps, or PCR tubes (0.1 ml) with caps from the 

four-pieces-strips (detection through the bottom of the tube). 

Programming the instrument 

1. Turn on the instrument, run the Rotor-Gene software. 

2. Insert the tubes or strips into the rotor of the Rotor-Gene 3000/6000/Q instrument 

beginning from the first well (the rotor wells are numbered, the numbers are used for the 

further programming of the samples’ order in the thermocycler). Insert the rotor into the 

instrument, close the lid. 

NOTE: 

Well 1 must be filled with any test tube except for an empty one. If tubes with 
different types of reaction mixtures are placed in the thermocycler simultaneously, 
tube with the PCR-mix-1-FEP/FRT EIEC / EHEC / STI should be placed in the 
first well. If the tubes with reagents from different PCR kits or with different PCR-
mixes are inserted into the rotor then the tubes’ numbers for calibration in each 
detection channel should be indicated in the Rotor-Gene software. 
Recommendations about the calibration are described in the information list 
“Calibration priorities for the AmpliSens kits for Rotor-Gene 3000/6000 (Corbett 
Research, Australia) and Rotor-Gene Q (QIAGEN, Germany) thermocyclers”. 

3. Program the instrument according to the Instruction Manual provided by the 

manufacturer. 

Creating the template for the run 

1. Click the New button in the software main menu. To create the template select the 

Advanced tab in the opened window New run. 

2. Select the TwoStep/Hidrolysis Probes template in the tab for edition and click The 

New button. 

3. In the opened window select the 36-Well Rotor (or 72-Well Rotor) and tick the No 

Domed 0,2ml Tubes / Locking Ring Attached option. Click the Next button. 

4. In the opened window enter the operator name; select the reaction volume – 25 µl.  

5. In the New Run Wizard window set the temperature profile of the experiment. To do 
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this click the Edit profile button and set the amplification program: 

The amplification program for rotor-type instruments 
Step Temperature, °С Time Fluorescence detection Number of cycles 

1 95 15 min – 1 

2 

95 10 s – 

45 60 25 s FAM, JOE, ROX 

72 10 s – 
 

Note – The Cy5 and Cy5.5 channels are enabled when required if the “multiprime” format 

tests are performed. 

6. After setting up the temperature profile click the OK button. 

7. Set calibration parameters (activate Calibrate/Gain Optimization… in a new 

experiment module): 

a) for signal measurement optimisation for the selected channels set calibration from 

5Fl to 10Fl for the channels FAM/Green, JOE/Yellow and ROX/Orange. It is 

acceptable to set Calibrate/Gain Optimisation… value from 3Fl to 7Fl for 

FAM/Green and JOE/Yellow channels. 

To do this, click the Calibrate Acquiring/Optimise Acquiring button. In the opened 

window for first channel (Auto Gain Optimisation Channel Settings/Auto Gain 

Calibration Channel Settings) indicate the values of minimum and maximum 

signal in the Target Sample Range line. Click the OK button. The window for the next 

channel will open automatically. The selected values for all the channels can be 

checked in the Min Reading, Max Reading boxes. 

NOTE: 

The additional requirements for setting the channels’ calibration ranges are 
specified in the information list “Calibration priorities for the AmpliSens kits for Rotor-
Gene 3000/6000 (Corbett Research, Australia) and Rotor-Gene Q (QIAGEN, 
Germany) thermocyclers” 

b) perform the calibration in the selected channels before the first detection (tick the 

Perform Calibration Before 1st Acquisition/ Perform Optimisation Before 1st 

Acquisition option). Click the Close button. 

8. Click the Next button. For saving the programmed template it is necessary to click the 

Save Template button and enter the template file name, corresponding to the 

amplification program – AmpliSens. Save the file into a proposed folder: 

Templates\Quick Start Templates; close the New Run Wizard window. After that the 

programmed template will appear in the template list in the New Run window. 

Using the ready template for the run 

1. Click the New button in the software main menu. In the opened New Run window 

select the Advanced tab. Then select the AmpliSens template (which is programmed 
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as described in the “Creating the template for the run” section) in the template list.  

2. In the opened window select the 36-Well Rotor (or 72-Well Rotor) and tick the No 

Domed 0,2ml Tubes / Locking Ring Attached option. Click the Next button.  

3. In the opened window check that the reaction volume is 25 µl. Click the Next button. 

4. In the next window the correctness of the amplification program and signal level auto-

optimisation parameters can be checked. Go to the next window clicking the Next 

button. Start the amplification by the Start run button. Herewith, the rotor with the 

samples should be already fixed and the lid should be closed. Name the experiment 

and save it to the disc (the results of the experiment will be automatically saved in this 

file). 

5. Enter the data into the grid of the samples (it opens automatically after the amplification 

has been started). Enter the names/numbers of the test samples in the Name column. 

Define the Negative control of amplification as NCA, the Positive control of amplification as 

C+. Set the type Unknown opposite all the test samples, the type Positive control – for 

the Positive control of amplification, the type Negative control – for the Negative control of 

amplification. Set the type Standard for DNA-calibrators C1 and C2 and enter the values 

from the Important product information bulletin enclosed to the given lot of the PCR kit into 

the Given conc. column. Set the type None for the cells matching with the 

corresponding empty tubes. Click the Finish/OK button. 

NOTE: Samples indicated as None won’t be analysed. 

Note – To edit the table of samples before the start it is needed previously to select the Edit 

Samples Before Run Started option in the User preferences submenu of the File menu. 

Data analysis 

The obtained results are analyzed by the Rotor-Gene software. The results are interpreted 

according to the crossing (or not-crossing) of the S-shaped (sigmoid) fluorescence curve 

with the threshold line set at the specific level, that corresponds to the presence (or 

absence) of the Ct (threshold cycle) value of the DNA sample in the corresponding column 

of the results table. 

Amplification data analysis in the FAM/Green channel: 

1. Activate the Analysis button in the menu, then select the mode of the analysis 

Quantitation, activate the Cycling A. FAM/Cycling A. Green, Show buttons. 

2. Cancel the automatic choice of the threshold line level Threshold. 

3. Select the Linear scale. 

4. Activate the Dynamic tube and Slope Correct buttons in the menu of main window 
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(Quantitation analysis). 

5. In the CT Calculation menu (in the right part of the window), set Threshold = 0.05.  

6. Choose the parameter More settings/Outlier Removal and set 10 % for the value of 

negative samples threshold (NTC/Threshold). 

7. In the results grid (the Quantitation Results window) one will be able to see the Ct 

values. 

Results analysis in the JOE/Yellow, ROX/Orange channels is carried out similarly to 

results analysis in the FAM/Green channel in accordance with the settings in the table 

below. 

Channel Threshold Dynamic tube Slope Correct More Settings/Outlier Removal 

FAM/Green 0.05 on on 10% 

JOE/Yellow 0.05 on on 10% 

ROX/Orange 0.05 on on 10% 

Results interpretation 

The result of the PCR analysis is considered reliable only if the results for the controls of 

the amplification and the extraction are correct in accordance with the table of assessment 

of results for controls (see the Instruction manual) and boundary values specified in the 

Important Product Information Bulletin enclosed to the PCR kit. 

The interpretation of the test samples is to be carried out in accordance with the Instruction 

Manual and the Important Product Information Bulletin enclosed to the PCR kit. 



iCycler iQ5 
 

REF  R-B62(RG,iQ)-CE; REF  R-B62(RG,iQ)-CE-B / VER  27.08.25-04.09.25 / Page 8 of 15 

AMPLIFICATION AND DATA ANALYSIS USING iCycler iQ5 (Bio-Rad Laboratories, 

Inc., USA) INSTRUMENT 

Carry out the sample pretreatment and reaction mixture preparation stages according to 

the PCR kit Instruction Manual. When carrying out the amplification it is recommended to 

use thin-walled PCR tubes (0.2 ml) with domed or flat optically transparent caps, or tubes 

(0.2 ml) with transparent caps from the eight-pieces-strips (detection through the cap of 

the tube). 

Programming the thermocycler 

1. Turn on the instrument and the power supply unit of the optical block of the instrument. 

NOTE: Warm up the lamp for 15 min before starting the experiment. 

2. Start the program iCycler iQ5.  

3. Insert the tubes or strips into the reaction module of the thermocycler and program the 

instrument according to the Instruction Manual given by the manufacturer of the 

instrument. 

NOTE: 

Monitor the tubes. There must not be drops left on the walls of the tubes as 
falling drops during the amplification process may lead to the signal failure and 
complicate the results analysis. Don’t turn the tubes (strips) upside down while 
inserting them into the instrument. 

Creating the template for the run 

1. Set the plate setup (set the order of the tubes in the reaction chamber and the 

detection of fluorescent signal). 

– click the Create New button in the Selected Plate Setup window of the Workshop 

module; 

– in the opened window click the Whole Plate loading button and set the plate setup 

using the buttons of the upper toolbar. Enter the samples’ names in the 

Identifier/Condition column in the bar appeared in the screen bottom. Select the 

fluorescent signal detection in the FAM, JOE/HEX, ROX channels. Click the 

Select/Add Fluorophores button, select the fluorophore and tick it in the Selected 

column. Click OK. The fluorophore name will appear in the Fluorophore window. 

For addition of fluorescence signal measuring for each sample it is necessary to 

click the fluorophore (activate it) and select the samples on the plate using the 

Fluorophore loading in whole Plate mode  button under the scheme; 

– set the reaction volume (Sample Volume) as 25 µl, the caps type (Seal Type) as 

Domed Cap, and the tubes type (Vessel Type) as Tubes; 

– save the set plate setup by clicking the Save&Exit Plate Editing button. Enter the 
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file name and click Save. 

2. Set all the biological samples as Unknown, positive controls as «+», and negative 

controls as «–». 

3. Set the amplification program. To do this, in the Selected Protocol window of the 

Workshop module click the Create New button. Set the amplification parameters and 

save the protocol by activating the Save&Exit Protocol Editing button. Enter the name 

of the file and then click Save. 

The amplification program for plate-type instruments 

Step Temperature, °С Time Fluorescence detection 
Number of 

cycles 

1 95 15 min – 1 

2 

95 10 s – 

45 60 25 s FAM, JOE/HEX, ROX 

72 10 s – 

Note – The Cy5 and Cy5.5 channels are enabled when required if the “multiprime” format 

tests are performed. 

4. Before a run it is obligatory to check if the selected protocol (Selected Protocol) and 

the plate scheme (Selected Plate Setup) are correct. To begin a run click the Run 

button. For the well factors measurement the Use Persistent Well Factors type is 

selected by default. Click the Begin Run button, save the experiment (the results of 

this experiment will be automatically saved in this file) and click OK. 

5. At the end of the run it is necessary to close the software and turn off the instrument (the 

thermocycler and the optical block).  

Using the ready template for the run 

The test parameters and the plate setup set earlier can be used for the further runs. To do 

this: 

– select the needed file with the run in the upper left window of the Workshop module; 

– click the Edit button in the Selected Plate Setup area of the Workshop module and 

edit the plate setup (the files of protocols are saved in the SampleFiles folder by 

default); 

– click the Edit button in the Selected Protocol area of the Workshop module and 

check the correctness of the selected protocol (the files of protocols are saved in the 

SampleFiles folder by default). 

Data analysis:  

The obtained results are analyzed by the iCycler iQ5 software. The results are interpreted 

according to the crossing (or not-crossing) of the S-shaped (sigmoid) fluorescence curve 
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with the threshold line set at the specific level, that corresponds to the presence (or 

absence) of the Ct (threshold cycle) value in the corresponding column of the results table.  

1. Start the software and open the needed file with data of the analysis in the Data File 

window of the Workshop module. Click the Analyze button.  

2. Select the Analysis Mode: PCR Base Line Subtracted Curve Fit (is set by default). 

3. Check the correctness of threshold line automatic choice for each channel. The 

threshold line is to cross only with S-shaped (sigmoid) curves describing the 

accumulation of the signal detecting positive samples and controls. The threshold line 

is not to cross the base line. If it happens, it is necessary to set the threshold line level 

for each channel manually. To do this, click the Log View (logarithmic scale selection) 

and set (with the left mouse button) the threshold line at the level where the 

fluorescence curves have a linear character and do not cross with the curves of the 

negative samples. As a rule, the threshold line is set at the level of 10-20 % of 

maximum fluorescence obtained for the Positive control in the last amplification cycle. 

Make sure that the fluorescence curve of the Positive control has the typical 

exponential growth of fluorescence. 

4. In order to analyse the results click the Results button which is situated under the 

buttons with the fluorophores’ names. 

Results interpretation 

The result of the PCR analysis is considered reliable only if the results for the controls of 

the amplification and the extraction are correct in accordance with the table of assessment 

of results for controls (see the Instruction manual) and boundary values specified in the 

Important Product Information Bulletin enclosed to the PCR kit. 

The interpretation of the test samples is to be carried out in accordance with the Instruction 

Manual and the Important Product Information Bulletin enclosed to the PCR kit. 
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AMPLIFICATION AND DATA ANALYSIS USING Mx3000P (Stratagene, USA) 

Carry out the sample pretreatment and reaction mixture preparation stages according to 

the PCR kit Instruction Manual. When carrying out the amplification it is recommended to 

use thin-walled PCR tubes (0.2 ml) with domed or flat optically transparent caps, or tubes 

(0.2 ml) with transparent caps from the eight-pieces-strips (detection through the cap of 

the tube). 

1. Switch on the instrument. Run the Stratagene Mx3000P software. 

2. Select Quantitative PCR (Multiple Standards) and Turn lamp on for warm-up in the 

New Experiment Options window.  

NOTE: The lamp is to be warmed up during 15 min before starting the experiment 

3. Insert the tubes into the instrument, and close the fixer and the door of the instrument. 

4. Select Optics Configuration in Options menu and, in the Dye Assignment tab, set 

parameter FAM next to the FAM filter set item, parameter JOE/HEX next to the 

HEX/JOE filter set and parameter ROX, next to the ROX filter set. 

5. Set fluorescence detection parameters in the Plate Setup menu. To do this: 

 Select all wells with tested tubes or strips; 

 Mark all selected wells as Unknown in the Well type window. Select FAM, JOE 

and ROX fluorophores for the Collect fluorescence data option. 

6. Name each sample in the Well Information window. 

7. Set amplification program in Thermal Profile Setup tab for the plate-type instrument 

(see the Instruction manual for the PCR kit). To do this: 

A. Press the Import… button. Navigate to the folder containing the previous 

experimental file and open it. The required thermocycling profile will appear in the 

Thermal Profile window; 

B. Set the appropriate amplification program in Thermal Profile Setup menu. 

Amplification program for plate-type instruments 

Step Temperature, °С Time Number of cycles 

1 95 15 min 1 

2 

95 10 s 

45 60 
25 s 

Fluorescent signal detection 

72 10 s 
 

NOTE: 

If the given PCR kit is used with the kit for setting the parameter of the 
fluorescence signal detection at the set temperature it is necessary to select the 
All points option for the Data collection marker for dragging parameter and 
drag it with a mouse from the right part of the box to the field with the necessary 
temperature. 
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8. Select the Run button, then the Start button, and name the file. 

Data analysis 

The results are interpreted according to the crossing (or not-crossing) of the S-shaped 

fluorescence curve with the threshold line (set in the middle of the linear fragment of 

fluorescence growth of the positive control in the log scale) and shown as the presence (or 

absence) of the Ct (threshold cycle) value in the results grid.  

1. Select Analysis by clicking the corresponding button of the tool bar. 

2. The Analysis Selection/Setup tab will open. Make sure that all the test samples are 

active (the cells corresponding to the samples should be of a different colour). 

3. Select the Results tab. 

4. Make sure that the automatic selection of the threshold level for each channel is 

correct. Normally, the threshold line should cross only the sigmoid curves of signal 

accumulation of positive samples and controls and should not cross the baseline. 

Otherwise, the threshold level should be raised. To do this, activate each channel 

image separately in the lower Dyes shown panel. Check the threshold line location 

and change it, if necessary. 

Results interpretation 

The result of the PCR analysis is considered reliable only if the results for the controls of 

the amplification and the extraction are correct in accordance with the table of assessment 

of results for controls (see the Instruction manual) and boundary values specified in the 

Important Product Information Bulletin enclosed to the PCR kit. 

The interpretation of the test samples is to be carried out in accordance with the Instruction 

Manual and the Important Product Information Bulletin enclosed to the PCR kit. 
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AMPLIFICATION AND DATA ANALYSIS USING CFX96 (Bio-Rad, USA) 

Carry out the sample pretreatment and reaction mixture preparation stages according to 

the PCR kit Instruction Manual. When carrying out the amplification it is recommended to 

use thin-walled PCR tubes (0.2 ml) with optically transparent domed or flat caps, or tubes 

(0.2 ml) with transparent caps from the eight-pieces-strips (detection through the cap of 

the tube). 

Programming the thermocycler 

1. Turn on the instrument and start the Bio-Rad CFX Manager software. 

2. Program the instrument according to the Instruction Manual provided by the 

manufacturer  

Creating the template for the run 

1. In the Startup Wizard window it is necessary to select the Create a new 

Run/Experiment (or select New in the File menu and then select 

Run…/Experiment…). Click OK. 

2. In the Run Setup window, select Protocol and click the Create new… button. Set 

amplification parameters (time, temperature, cycles, and fluorescence acquiring cycle) 

in the opened Protocol Editor – New window. Set Sample Volume – 25 μl. 

Amplification program for plate-type instruments 

Step Temperature, °С Time 
Fluorescence 

detection 
Number of cycles 

1 95 15 min – 1 

2 

95 10 s – 

45 60 25 s FAM, HEX, ROX 

72 10 s – 

NOTE: 
Set Ramp Rate 2,5 °С/s by clicking the Step Options button for each step of 
cycling (see the figure below). Click OK. 

Note – The Cy5 and Cy5.5 channels are enabled when required if the “multiprime” format 

tests are performed. 

3. Save the protocol: in the Protocol Editor New window select File, then Save As, and 

name the file and click Save.  

When the required program is entered or edited, click OK at the bottom of the window. 

4. Set the plate setup: in the Plate tab click the Create new… button. Set the tube order 

in the opened Plate Editor – New window. Click the Select Fluorophores… button 

and click the Selected checkbox next to the FAM, HEX, ROX fluorophores and click 

OK. In the Sample type menu select Unknown for all the samples. Then in the Load 

column (in the right part of the window) tick the fluorescence signal acquiring for all the 

samples in the required channels. Define sample names in the Sample name window, 
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confirming the names by the Load button. 

6. Save the plate setup: select File and then Save as in the Plate Editor New window. 

Enter the file name, click Save. 

7. Select the Start Run tab. Open the lid of the instrument by the Open Lid button. Insert 

the reaction tubes in the wells of the instrument in accordance with the entered plate 

setup. Close the lid by the Close Lid button. 

NOTE: 

Monitor the tubes. There must not be drops left on the walls of the tubes as 
falling drops during the amplification process may lead to the signal failure and 
complicate the results analysis. Don’t turn the tubes (strips) upside down while 
inserting them into the instrument. 

8. Click the Start Run button and start the program with the selected plate setup. Select 

the directory for the file saving, name the file, click Save. 

Using the ready template for the run 

The test parameters and the plate setup set earlier can be used for the further runs. To do 

this: 

– click the Select Existing… button in the Run Setup window of the Protocol tab. Select 

the needed file with the amplification program in the Select Protocol window. Click Open. 

– go to the Plate tab in the Run Setup window. Click the Select Existing… button. 

Select the needed file with the plate setup in the Select Plate window. Click Open. Click 

the Edit selected button to edit the plate setup. 

Data analysis 

The obtained results are analyzed by the software of the CFX96 instrument. The results 

are interpreted according to the crossing (or not-crossing) of the S-shaped (sigmoid) 

fluorescence curve with the threshold line set at the specific level, that corresponds to the 

presence (or absence) of the Ct (threshold cycle) value in the corresponding column of the 

results table. 

1. Start the software and open the saved file with data of the analysis. To do this, select 

File in the menu, then Open and Data file and select the needed file. 

2. The fluorescence curves, the tube order in the plate and the table with the Ct values 

are represented in the Data Analysis window of the Quantification tab. 

Check the correctness of threshold line automatic choice for each channel. The threshold 

line is to cross only with S-shaped (sigmoid) curves describing the accumulation of the 

signal detecting positive samples and controls. The threshold line is not to cross the base 

line. If it happens, it is necessary to set the threshold line level for each channel manually. 

To do this, tick the Log Scale item (logarithmic scale selection) and set (with the left 

mouse button) the threshold line at the level where the fluorescence curves have a linear 
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character and do not cross with the curves of the negative samples. As a rule, the 

threshold line is set at the level of 10-20 % of maximum fluorescence obtained for the 

Positive control in the last amplification cycle. Make sure that the fluorescence curve of the 

Positive control has the typical exponential growth of fluorescence. To select the curve of 

C+ sample (or another one appropriate sample), set the cursor to the plate setup or to the 

results grid. 

Results interpretation 

The result of the PCR analysis is considered reliable only if the results for the controls of 

the amplification and the extraction are correct in accordance with the table of assessment 

of results for controls (see the Instruction manual) and boundary values specified in the 

Important Product Information Bulletin enclosed to the PCR kit. 

The interpretation of the test samples is to be carried out in accordance with the Instruction 

Manual and the Important Product Information Bulletin enclosed to the PCR kit. 

List of Changes Made in the Guidelines  

VER Location of changes  Essence of changes 

04.09.25 
HM 

Intended use 
Correspondence of the fluorophores and detection channels 
table was added 

Amplification and data 
analysis using Rotor-
Gene 3000/6000 
(Corbett Research, 
Australia) AND Rotor-
Gene Q (QIAGEN, 
Germany) instruments 

The optimization of signal measurement for FAM/Green, 
JOE/Yellow channels has been changed from «3Fl to 7Fl» to 
« 5Fl to 10Fl». The note «It is acceptable to set 
Calibrate/Gain Optimisation… value from 3Fl to 7Fl for 
FAM/Green and JOE/Yellow channels» has been added  

Amplification and data 
analysis using iCycler 
iQ5 (Bio-Rad 
Laboratories, Inc., USA) 
instrument 

Corrections according to the template 

Amplification and data 
analysis using 
Mx3000P (Stratagene, 
USA) 

Corrections according to the template 

Amplification and data 
analysis using CFX96 
(Bio-Rad, USA) 

Corrections according to the template 

 


